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Introduction

Adxv is a program to graphically display and analyze 2-D area detector data. It is
optimized to display X-Ray crystallography diffraction images. Many common data
formats are recognized, including ADSC SMV/IMG, CBF and HDF5. The data may be
displayed as a 1-D cross section, 2-D image or 3-D surface. Sequential images may
be displayed as an animation. The magnification, contrast and color mapping are
adjustable. Displayed data may be saved in a variety of formats including ASCII,
SMV/IMG, TIFF, JPEG and Postscript.

Adxv will run on most versions of Linux and OSX. It is based on X11/Motif so an X-
server is required. It will run on Windows if the Cygwin libraries have been
installed and an X-server is running.

Adxv is freely available to everyone. There is no registration, license or fee
required to use it. You can download it from:

www.scripps.edu/~arvai/adxv.html

This manual is available here:

www.scripps.edu/~arvai/adxv/AdxvUserManual.pdf

The current version of Adxv is 1.9.10.



A Brief History of Adxv

In 1992 The Scripps Research Institute (TSRI) got a new Mar Image Plate Scanner. It
was a great detector, although it used the VMS operating system and the display
software (XIPS) was not so great. So | wrote a program called Xvip to display images on
our Unix (Sun) workstations. Xvip was written in C and used the X11/Xview graphics
libraries.

_File... ) Save... Show + ) _Quit )
Scale:
Contrast
100% Min Max
—
3k 1 - 295
S50%
25%

W Color: On | Off  Magnify: ’Tilﬂi,
Predict: On |0ff Pixel Value
-

Loading /home/arvai/andy?2_1_001.1image.Z
Distance: 230 mm, Lambda: 1.540 A
2000 % 2000 pixels, O overflows |
MaxI: 64331, Avgl: 67
Scale factor: 0.31

Xvip, circa 1993

Our Sun workstations were monochrome, so grayscale images were displayed using
dithering. When we got color workstations, | modified Xvip to work with grayscale and
color. A later version of Xvip was given to Mar Research, which evolved into what is
now their MarView display program. In 1993, in collaboration with ADSC, | created a
version of Xvip which was better suited for SAXS data. This program was called Marvip.
In 1994 | combined the best features of Xvip and Marvip into the first version of Adxv.
This was written with the X11/Motif libraries. Over the years Adxv has slowly evolved
by adding more features, supporting more data formats and supporting the latest
computers and operating systems.

Adxv. There is no substitute.



Supported File Formats

Format

ADSC SMV/IMG (16 and 32-bit integer)
Bruker

CBF (Standard and “mini-CBF”)

EDF

Fuji Image Plate

HDF5

MarCCD

Mar Image Plate

NUMPY

R-AXIS

TIFF (8, 16, 32 Bits/Pixel with 1 Sample/Pixel)
Raw binary (8, 16, 32-bit integer and 32-bit float)

Adxv spot file
Cheetah pixelmap file

CrystFEL geometry file

Denzo .x file

File Extension
.img

sfrm

.cbf

.edf

fuji

.h5 / .hdf5

.mccd

.image / .marxxxx

npy

.0SC
if /.aff

any

.adx
.h5

.geom

Adxv recognizes many file formats based on the file header, so the file extension can
be anything. Files which have been compressed with gzip, compress or bzip may be

read without uncompressing them.

The internal data representation of Adxv is 32-bit signed integer. If an input data
format is floating point and the data values are very small or very large, you may
want to run Adxv with the —iscale command line option to multiply the data by a

scale factor before conversion to integer.



Notes for HDF5 files

HDF5 files are containers for two kinds of objects - Datasets and Groups. Datasets
contain multidimensional arrays of data and Groups are container structures
which may contain Datasets or other Groups. Groups are analogous to
directories and Datasets are like files.

By default Adxv will try to open the following Datasets in an hdf5 file:

/data

/data/data

/intensities

/real

/entry/data

/entry/data/data

/entry_1/data_1/data
/entry_1/image_1/data
/entry_1/instrument_1/detector_1/data
/entry/instrument/detector/data

If none of these are found, the Info Window is raised and you can examine the file
header to find the dataset name. You can either double-click on the dataset or next
time you can start Adxv with:

" Adxv Info <@rad10>

adxv -hdf5dataset <datasetname> 7
fentry/
;entrvfggta{dd
. . entry/dat ata =5x 2527 x 2463, H5T_STD_I3:
In the Info Window to the right, the Jentry/data/x = (2463 values)
dataset name is /entry/data/data ﬁgggﬁzﬁgg‘;?;’:;,g,f2jﬁ§;§'“9‘53'
Jentryfend_time = 2013-02-08T12:03:13.589
fentrvfjnstrumentf
An hdf5 file may contain multiple /entry/instrument/attenuator/ o
] ] Jentry/instrument/attenuator/attenuator_transmissic
datasets, each of which will be ientrvﬁinstrumentﬁgetectorﬁb
. . . . entry/instrument/detector/beam_center_x = 0.2124
highlighted in a bold font in the Info fentry/instrument/detector/beam_center_y = 0.2200
Window Jentry/instrument/detector/count_time = 0,1975 0.1

Jentry/instrument/detector/dead_time = 1.991e-07

Jentry/instrument/detector/depends_on = fentry/ins
) ) fentry/instrument/detector/description = PILATUS EM
For more information about hdf5 fentry/instrument/detector/distance = 0,19018 0.19¢

files see page 29 (Load Window)
and page 41 (Info Window). Close |




Starting Adxv

The usage to start Adxv from the command line is:

adxv [options] [file [predictions]]

The options which may be specified on the command line are listed starting on
page 58. Following any command line options is the name of an image file to load.
After the image file, a file with spot positions may also be specified.

For example to display an image you can do:
adxv test_1_001.img

Two windows will appear - the Control Window and the Image Window. The Image
Window graphically displays the image using a grayscale colormap. Larger pixel
values are darker and smaller pixel values are lighter. As the mouse is moved
around the Image Window, the position of the cursor is displayed in both
millimeters and pixels. The resolution (in Angstroms) and 1/Sigma of the region
under the cursor are also displayed.

In the Image Window, the Left mouse button may be pressed, dragged and then
released to produce a 1-d cross-section plot. This plot will be displayed in a new
Line Window. The middle mouse button may be pressed and dragged to "pan"
around the image. Pressing the right mouse button will magnify and display the
area under the cursor in a separate Magnify Window.



The Control Window may be used to modify the appearance of the displayed
image. In the center of this window is a graphical display of the pixel to color
mapping and immediately to the right of this is a vertical slider. Dragging the slider
will adjust the contrast of the image. Pixel values larger than the value in the text
box above the slider are drawn as black (or the top color in the colormap), and
pixel values smaller than the value below the slider are drawn as white (or the
bottom color in the colormap). There are radio buttons to adjust the image scale,
and colormap. The default Scale is Auto and this will scale the image so it fits
inside the Image Window. If 100% is selected, then each pixel in the image will be
drawn as 1 pixel on the screen. If 50% is selected, then every other pixel in the
image will be drawn. There are 3 choices for colormap (Gray, Heat and Rainbow).
Each of these may be inverted. For example if the Gray color map is inverted, then
large pixels are White and small pixels are Black.

The magnification factor used to display data in the Magnify Window may be
adjusted from 1 to 128. If this is set to 8, then each pixel in the image will be
drawn as an 8x8 pixel in the Magnify Window. The data in the Magnify Window
may be displayed as Values, Pixels or 3-D. If Values is selected, then only numbers
will be displayed. If Pixels is selected, then a magnified view of the pixels is
displayed. If 3-D is selected, the data is displayed as a three-dimensional wire
mesh.

Other Adxv windows can be accessed from the Control Window. Clicking with the
Left mouse button on the menu bar at the top of the Control Window will display
a menu with choices of Windows to display. Each of these windows, as well as the
Control Window and Image Window, will be shown and explained in more detail
later.

If the Control Window is not visible, simultaneously pressing the <SHIFT> key and
the right mouse button in either the Image or Magnify Window will raise the
Control Window to the top.



Examples

Display an image and overlay spots from a .adx file:
adxv Thau2_1_031.img Spots.adx
Draw resolution rings at 4 specific resolutions:
adxv -rings 8 3.5 2 1.5 trypsin_2_001.img
Display 1152x1152 binary unsigned short data, skip 2048 byte header and swap bytes:
adxv -ushort -nx 1152 -ny 1152 -skip 2048 -swap test_001.raw
Display an image and denzo predictions:
adxv nnos6_1_001.img nnos6_1_001.x
Specify an exact visual id and use OpenGL for the 3-D display:
adxv -visual 0x26 -gl
Read an HDFS5 file and specify which dataset to display:
adxv -hdf5dataset /entry_1/image_1/data cxidb-3.cxi
Convert an image from CBF to IMG :

adxv -smv32bits —sa G8_1_00001.cbf G8_1_00001.img



Automatically save an image as a 1/10 scale jpeg file:

adxv -sa -jpeg_scale 0.1 nnos6_001.img nnos6_001.jpeg

Crop a 100x100 pixel region, where the upper left corner is at x=200, y=300, from an
hdf5 file and save it as a 32-bit .img file.

adxv —smv32bits -sa -sa_crop 100x100+200+300 dark.h5 dark.img

Display CSPAD data and use a CrystFEL detector geometry file to correct the image:

adxv -pixelmap cspad.geom CxiDs1-image.h5

Display CSPAD data and use a Cheetah pixelmap file to correct the image:

adxv -pixelsize 0.110 -pixelmap pixelmap.h5 CxiDs1l-image.h5

Use a larger font for the resolution rings. This will help if you have a large image, scale to
100% and then save as jpg or tiff:

Here’s a short script to make a movie from a series of images:

#! /bin/csh

foreachi ( lyso_*.img )

adxv -sa $i /tmp/Si:r.jpg

end

ffmpeg -r 25 -i /tmp/lyso_%03d.jpg -vb 20M lyso.mpg



The Control Window

a

Histogram F Image
Image Header... Magnify

The top row contains a menu bar.
Selecting one of these menu buttons will
display a pull down menu. The items in
these pull down menus will be discussed
later.

Predirtinns._..
Load...l L.
Statistics...
Save...
Esxcit... Settmg'_f...
— Properties...
Background...
o
File View Edit Help
Scale
_)25% _)50% _)100% ( Auto
~Colormap— -
© Gray g
_J) Heat
_J Rainbow
_I Invert 300 :I
—Magnify— 240
_J3-D 180
@ Pixels 120
|8E§’
_JValues -
Magnification
1 )2 4 €8 16 )32 )64 U

Loading C3_1_00001.img

3072 % 3072 pixels

Distance: 180 mm, Lambda: 1.033 A
Maxl: 65535, avgl: 186

35 Overflows (19 Spots)

Scale factor: 0.19

Adjusts the scale of the image in the
Image Display Window. When the scale
is 100%, every pixel is displayed so that
1 pixel in the image is 1 pixel on the
screen. When the scale is 25%, every 4th
pixel in the image is displayed on the
screen. For example if the image is
3072x3072 pixels and the scale is 25%,
then the image displayed on the screen
will be 768x768 pixels. When Auto is
selected, the image is scaled so it fits
inside the Image Window. The scale is
calculated as the width of the image
divided by the width of the Image
Window. For example if the Image
Window is 600 pixels wide and the image
is 3072 pixels wide the scale will be
600/3072=0.195.

See examples below.
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50% 100%

The Image Window showing the same image displayed at different scales. When
the scale is 25% or larger the image does not fit completely inside the Image
Window. In this case, you can press and hold the Middle mouse button to move
the image around. The beam center is drawn as a red cross in each image. .



File View Edit Help displayed

Scale
)25% _)50% _)100%  Auto

~Colormap
© Gray
_J) Heat

dark Red.

) Rainbow

Magnification——
N Js 4 @8 16 )32 64 U

This inverts the colormap. For example, with Gray,
larger pixel values are Black. When Invert is selected,
larger pixel values are White.

See examples of different colormaps below.

in the

540
480
420
360

Heat

Adjusts the colormap of the image
Image and Magnify
Windows. For example with Heat, larger
pixel values are light Yellow, intermediate
values are Orange and smaller values are

Rainbow

Gray + Invert
13



The Image Window showing different colormaps

Gray

Heat Heat + Invert

14

Rainbow + Invert



Pixel values larger than this value are
drawn as Black. This may also be set and
displayed in the Histogram Window.

File View Edit

Scale
_J25% _50% _)100%
-Colorma
© Gray
_J Heat

_J Rainbow

| Invert .
—— Fix Contrast

—Magnify— Auto

_J3-D 80
© Pixels 120

_ |BE?
_JValues -
— - —Mafnification

D1 02 4 B8 16 )32 J6AY

.

Loading C3_1_0@001.img

3072 ® 3072 pixgls

Distance: 180 , Lambda: 1.033 &
Maxl: 65535, AVl 186

95 Overflows {(#3 Spots)

Scale factor: 0.79

Graphical display of pixel value vs.
color mapping. For example a pixel
value of 360 will be drawn in
medium gray and a pixel value of 120
will be drawn in light gray. The
Middle mouse button may be pressed
and dragged in this window to
stretch and adjust the colormap. The
behavior is analogous to stretching a
rubber sheet. Selecting a different
colormap or moving the contrast
slider will reset the colormap.

Slider to adjust the contrast.
Dragging this up increases the
contrast and dragging it down

decreases the contrast.

Pixel values smaller than this are
drawn as White. May also be set and
displayed in the Histogram Window.

If the Right mouse button is pressed in the colormap drawing area, this
popup menu appears. Selecting “Fix Contrast” will not automatically

update the contrast setting for each image

as it is loaded. The Max and

Min contrast settings will remain as from the last image loaded or as set

by the user. This may also be set in the

Settings window. When Fix

Contrast is set, the Max and Min contrast values in the textboxes to the

right will be drawn in a Bold font.
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[~ AdwcConwo |||

File View Edit Helpl

This selects how data is displayed in
the Magnify Window. If 3-D is
selected the data is displayed as a

Scale
_J25% _)50% _)100% ( Auto

~Colormap— . _ o
@ Gray wire mesh. Pixels displays magnified
) Heat pixels and Values prints only
_) Rainbow numbers. See examples on Page 22.

—I Invert

—Magnify— . . . .
y3-D Magnification factor of pixels drawn in
@ Pixels the Magnify Window. 8 means that
O values each pixel in the raw data is magnified

8 times and is drawn as an 8x8 pixel
box in the Magnify Window. The range
of magnifications is from 1 to 128. See
examples on Page 21.

———Magnification
1 02 4 @8 16 )32 )64 U

Loading C3_1_00001.img

3072 % 3072 pixels

Distance: 180 mm, Lambda: 1.033 A
Maxl: 65535, Avgl: 186

95 Overflows {19 Spots)

Scale factor: 0.19

There is more information about
magnification types and factors in the
Magnify Window section (page 20).

Information about the image which was loaded. Maxl is the largest pixel value in the
image. Avgl is the average pixel value. Overflows is the number of pixels which
have overflowed the linear range of the detector. Spots is the number of groups of
contiguous pixels which are overflowed, i.e. each “spot” may contain multiple
overflowed pixels. Scale factor is how much the image was scaled to fit in the
Image Window when the Scale mode is Auto. In this case the image is 19% the size
of the entire image, so about every 5™ pixel is displayed.

Loading C3_1_00001.img

If Adxv is started with the -verbose flag, more 3072 ® 3072 pixels
] . . . Distance: 180 mm, Lambda: 1.033 4
information is printed: — Minl: 0 at 0,0

=) [ Maxl: 65535 at 1612,1005
# of -1 pixels: 0

- 1 i # of -2 pixels: 0
The x,y position of the smallest and largest pixels Aval: 196, Siama: 345.5

-The number of -1 and -2 pixels 95 Overflows (19 Spots)
. L . . Scale factor: 0.19 16
-The standard deviation (sigma) of all the pixels




The Image Window

The The Image Window graphically displays the image using a grayscale colormap.
Larger pixel values are darker and smaller pixel values are lighter. As the mouse is
moved around the Image Window, the position of the cursor is displayed in both mm
and pixels. The resolution (in A) and the 1/Sigma of the region under the cursor is also
displayed. The beam center is drawn as a red cross in both the Image and Magnify
windows.

The left mouse button may be pressed, dragged along the window and then released
to produce a 1-d plot in a separate Line Window. The middle mouse button may be
pressed and dragged to "pan” the image if the image does not fit in the window.
Pressing the right mouse button will magnify and display the area under the cursorin a
separate Magnify Window. If the <SHIFT> key and Right mouse button are pressed
simultaneously, the Control Window will be raised. If the mouse has a scroll wheel,
then in Pixels and 3-D mode the scroll wheel can be used to adjust the magnification
factor in the Magnify Window from 1 to 128.

If the <SHIFT> key and Left mouse button are pressed simultaneously, a position on the
image is selected. Once three positions have been selected, the angle between
two consecutive lines described by those three positions will be printed to the
standard output. If two of the three positions are identical, the horizontal and vertical
angle (relative to the crystal origin) between the two points is printed. If all three points
are identical, the horizontal and vertical angle required to rotate that point to the
beam center is printed. These options were useful in the old days to measure the
angles of a lattice or estimate how far to rotate a crystal to align a zone.

If the <SHIFT> key and Middle mouse button are pressed simultaneously, the beam
center will be set to the cursor position. This may also be done in the Magnify Window.

With the cursor is in the Image Window, two numbers followed by a carriage return
may be typed and the Magnify Window will be raised and centered on that x,y pixel
position. If the Right mouse button is pressed while the <SHIFT> key is also pressed,
then the distance between successive clicks (in pixels and mm) will be printed to the
terminal.
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Image showing resolution rings. Notice that the beam center is drawn as a
red cross. For this image 2-theta is non-zero, so the resolution rings are
not circular. Resolution rings may be turned on or off in the Properties
Window, which is discussed later. The font used for the rings may be set
with the —rfont command line option. If you want to draw only the rings,
without the resolutions printed, you can use the —rings only command line
option. Rings may also be drawn at specific resolutions with the —rings

command line option.




The following keys may be typed while the cursor is in the Image Window

Arrow Keys

<SHIFT> +
Middle mouse
button

<SHIFT> +
Right mouse
button

Raise the Load Window. The File Load Window is displayed.

Adjust the histogram contrast in the Image Window. The contrast of the visible
portion of the data in the Image Window is automatically adjusted. Note that if
the entire image is not visible, only the pixels visible in the Image Window are used
to adjust the contrast.

Toggle lighting on and off in the Magnify Window. When using OpenGL
graphics, this will toggle turning lighting on and off.

Adjust the histogram contrast in the Magnify Window. The contrast of the Magnify
Window is automatically adjusted.

Toggle turning predictions on and off. When predictions are displayed, this will
toggle displaying them or not displaying them.

Reset the display in the 3-d magnify window. The position and orientation of the
data in the 3-d magnify window is reset to its original state.

Toggle smoothing in the Magnify Window. When using OpenGL graphics in line
mode (-gl_lines), this will toggle between drawing the wire mesh with smooth
lines (slower) or aliased lines (faster). When a surface is displayed this will
toggle between drawing aliased and anti-aliased polygons.

Toggle between wire mesh and surface display in the Magnify Window. When
using OpenGL graphics, this will toggle between a wire mesh and surface display
of the data.

Adjust the cursor position. Pressing the arrow keys (up, down, left, right) will
move the cursor by one pixel. If the Plot Type is Circle (set under Edit-
>Properties), the arrow keys will translate the center of the circle by one pixel.

Print help. This will print a summary of the keys which may be pressed.

Set the beam center to the current cursor position

Raises the Control Window. Also prints the distance between successive Right
mouse button clicks to the terminal.



The Magnify Window

The Magnify Window displays a magnified portion of the data from the Image Window.
Pressing the right mouse button in the Image Window draws a box and displays a
magnified view of the data within that box in a separate Magnify Window. The format of
the displayed data may be selected by toggle buttons in the Control Window (see
examples below). The default is "Pixels" where each pixel in the image is scaled by a
magnification factor and displayed. If the magnification factor is 32 or larger, the value
of each pixel will also be printed within each pixel. If "Values" is selected then only pixel
values will be printed, not a magnified image. If "3-D" is selected then a three
dimensional wire mesh representation of the data will be displayed. The function of the
mouse buttons is different with the different display modes.

In Values mode the Left and Right mouse buttons have no effect. The Middle mouse
button will pan the displayed data around the image.

In Pixels mode the Left mouse button will draw a line or circle (depending on the Plot
Type setting in the Properties Window). The Middle mouse button again pans around the
image and the Right button has no effect.

In 3-D mode the Left mouse button rotates the wire mesh. The Middle mouse button
translates the mesh (in X-Y) within the Magnify Window. The Right mouse button is
used to scale the wire mesh in the Z direction. If Control-Right mouse button is pressed
this will scale the wire mesh in all dimensions.

If the mouse has a scroll wheel, then in Pixels and 3-D mode the scroll wheel can be used
to adjust the magnification factor from 1 to 128.

If Adxv is started with the -gl command line, then OpenGL graphics is used for 3-D
mode.
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Comparison between Pixels, 3-D and Values.

[ AdwMagnify |||

Pixels

The same data is shown with Magnification set to Pixels (left) and 3-D (right).
The magnification is 4 in both cases.

. [ AdwMagnify |||

370 346 343 342 338 310 311 235 234 305

429 407 374 352 348 328 320 303 300 304

£13 448
597 513 448 406 363 344 338 330 328 319

929 718 G588 495 463 408 365 345 334 322

1789 1223 918 723 668 600 500 413 353 331
4542 1874 1300 1197 1128 994 786 534 462 391

3608 1517 1046 929 890 791 643 503 435 408

Mz 46
1966 1100 766 631 G535 518 467 430 412 416

398 41
1064 772 575 435 452 431 421 407 398 411

PiXels 700 575 483 451 403 332 377 380 391 408 Values

391 408

PR |

Notice that when the magnification is 32 or larger, the pixel values are printed
in each pixel. Depending on the number of digits needed for each value, a larger
or smaller font may be used so that the value will fit within a pixel . For Values
the magnification setting is disabled. The magnification depends on how many
pixels can be fit in the Magnify Window and is usually about 32.



The Magnify Window when using GL (-gl command line option)

Pixels. The colormap is Heat.

| .. Adxv Magnify <@rad10>

3-D Wire Mesh. Type “w” to toggle
between wire mesh and surface display.

. Adxv Magnify <@rad10>

3-D Surface. Type “1” to toggle lighting

on and off.
23




The following keys may be typed in the Magnify Window

Arrow Keys

<SHIFT> +
Middle mouse
button

<SHIFT> +
Right mouse
button

Raise the Load Window

Adjust the contrast to optimize display of the contents of the Magnify
Window

Toggle display of spots on / off
Reset orientation of 3-D display

Adjust the cursor position. Pressing the arrow will move the cursor by
one pixel.

Print help. This will print a summary of the keys which may be pressed

Set the beam center to the current mouse position

Prints the distance between successive Right mouse button clicks to the
terminal

The following keys may be typed when using OpenGL graphics (-gl)

This will toggle turning lighting on and off.

The position and orientation of the data in the 3-D Magnify Window will
be reset to its original state.

In line mode (-gl_lines), this will toggle between drawing the wire mesh
with smooth lines (slower) or aliased lines (faster). When a surface is
displayed this will toggle between drawing aliased and anti-aliased
polygons.

This will toggle between a wire mesh and surface display of the data.

Print help. This will print a summary of the keys which may be pressed.



The Load Window

This window is accessed by clicking File->Load from the Control Window and is used
to load files. Image files, Adxv spot (.adx), denzo output (.x) and CrystFEL
geometry (.geom) files may be loaded.

Directory where files are located

— Adxv Load ||
Directory: Pressing  the  List
|/data/lo/arvai/os2014/Cq button will list all files
- which  match  the
HEEEEIE '}'-IXKLZOOOX - regular expression in
*img List *Wﬁ ’ the Pattern text field.
| \ C3-1_00002.imq
File: C3-1_00003.imq ,
C3_1_00004.imq About 20000 files may
|c3_1_00008.im§ Load | |C3_1_00005.imq

« <«

>\ »

C3_1_00006.imq
C3_1_00007.img

C3_1_00008.img
C3_1_00009.imq
C3_1_00012.imq
C3_1_00013.imq
C3_1_00014.imq
C3_1_00015.imq
C3_1_00016.imq
C3_1_00017.imq

Stride: \i

Close

C3_1_00018.imq
C3_1_00019.imq
C3_1_00022.imq
C3_1_00023.imq
C3_1_00024.img

I~

be listed at once.
However, if there are
too many files, you can
list every 100’th file by
making the pattern

*01.img

*0.img
[A-C]*.h5
lys3_?_*.cbf

Regular expression(s) to filter which files are listed in the scrolling window to the
right. Some examples of patterns:

If Pattern is blank or *, all files are listed. Directories are always listed.

Typing a carriage return will re-scan the Directory for files matching the Pattera.




Directories are listed first, followed by files. Directory names have a trailing “/”.

Single-clicking a directory will change into that directory. Clicking the “.” directory

will move one directory up.

Double-clicking on a file will load and display that file.

\

=

Adxv Load

Directory:

|fdataf|ofarvaif052014;(:3

Pattern:

|*.im_6; List

File:

|c3_1_00008.imc_i Load

“« q » | »

Stride: [:1_

f

HKL2000/ N
OVERWRITTEN_FILES/
C3_1_00001.imq
C3_1_00002.i

C3_1_00006.imq
C3_1_00007.img

C3_1_00008.imq
C3_1_00012.imq
C3_1_00013.imq
C3_1_00014.imq
C3_1_00015.imq
C3_1_00016.imq
C3_1_00017.imq
C3_1_00018.imq
C3_1_00019.imq
C3_1_00022.imq
C3_1_00023.imq
C3_1_00024.img

L

Sort by Time
Sort Alphabetically

Close

J~d |~

Load and display the
file in the text field to
the left.

file in the list on the right

You can type a file name into this text field or select
one with the mouse from the list on the right. To load a
file you can either click the Load button, type a
carriage return in the text field or double-click on the

Pressing the Right
mouse button in the
file list section brings
up a menu where you
can choose to sort files
alphabetically or by
modification time. The
default is alphabetical.




When files are listed, they are not sorted absolutely alphabetically. Sorting also
takes into account run numbers and these are sorted from small to large. For
example, files are sorted like this:

data_1 001.img
data_2 001l1.img
data_10 001.img
data_11 001.img

not like this:

data_10_001.img
data_11 001.img
data_1 001.img
data_2 001.img

When Sort by Time is selected, more recent files are listed first, regardless of
file name. Directories are still listed first.

To re-scan files in a directory, press the List button or type a carriage return in
the Pattern text field.



Load and display the next file. In this case, the next file to load will be
C3_1_00013.img. This is because the current file is number 8 and the stride is 5. If
instead the left (previous) arrow button is pressed, then file number 3 would be
loaded.

When a new file is loaded, if the Line or Magnify Windows are displayed, their
contents will be updated to reflect the data in the new file. This also applies to
movie mode.

|— Agxv Load |- ]2
Directory:
|/data/lo/arvai/062014/CZ
Pattern: o 2]
HKL2000/
*imd List | [OVERWRITTEN_FILES/
C3_1_00001.imq
C3_1_00002.imq
File: C3_1_00003.imq
. ) C3_1_00004.imq
Specify every n'th |c3_1_00008.img: Load | [C3_1_00005.imq
: C3_1_00006.imq
file to load. For a1 00007 I
example if the C3_1_00008.imc
) . C3_1_00003.imq
Stride is 10, then £3-1-00010.Ima
. . 1 J1mqg
every 10’th file will ¢ C3_1_00012.imq
C3_1_00013.imq
Stride is 1, then J C3_1_00013.imq
. . ] C3_1_00016.imq
every file will be , - Stride: |3 S _1_00017.imq
loaded.
1 Close /
|~

Movie mode. Continually load and display the next file. Press again to stop. In this
case the Stride is 5, so every 5’th file (8, 13, 18, etc) will be continually loaded and
displayed. If files are displayed too quickly, a pause can be added between them
with the -delay command line option.




With three-dimensional hdf5 data, the Load Window will automatically show two
additional text fields and a checkbox. These are used to select which slab(s) to
display.

Specify the first slab to display. Each slab is a 2-d array of data. If the data is
100x2527x2463 pixels, then there are 100 slabs of data, where each slab is
2527x2463 pixels.

/

p—

/

Adxv Load

Directory:

|.Xdatafjatlab;’ar i/023014/G4
Pattern:

« <«

Load

>

+Slabs

Clhse

Stride: Fi__—

"

NDS/
_fff_J Ga_2_00001.h
G4 2_0000

o oooos'hs
4_2-00007.h5S
G4-2-00008.h5

Ca4_2_ 00010.h5
G4_2_00011.hS
G4_2_00012.hS
G4_2_00013.hS
C4_2_00014.h5
G4_2_00015.hS
C4_2_000186.h5
G4_2_00017.hS
G4_2_00018.hS
C4_2_00019.h5
G4_2_00020.hS
C4_2_00021.h5

[~

Number of slabs to
combine and display.
If Slabs is 5, then 5
slabs are summed and
displayed. How to
combine slabs (sum
or average) may be
specified in  the
Properties Window.

If this checkbox is checked, then the forward and backward arrows will
display the next slab of data, not the next file. For example if you are
displaying slab #1, the stride is 3, and you click the forward arrow button,

then slab #4 will be displayed. If there are no more slabs, then the next file

will be displayed.




Here a file (G4_2_00001.h5) is loaded which contains a total of 5 slabs.
The first slab to display is 2 and the number of slabs to combine is 3.
Thus, slabs 2-4 are combijéd and displayed.

— dxv Load
Directory:
'fdatafjatlab;’arvaifo 014/C4 /
Pattern: " I
*01.hg List | (sl J
_ .hS
hS
File: _00301.hS
¥_2_00401.hS
|G4_2_00 1.hg Load G4 2-00501.hS

G4_2_00B01.hS
G4_2_00701.hS
G4_2_00801.hS
G4_2_00301.hS
C4_2_01001.h5
G4_2_01101.hS
G4_2_01201.hS
G4_2_01301.hS

« “ " B  G4-2701401.hS
G4-2_01501.h
G4_2_01601.h5
| +Slabs Stride: |1 C4_2_01701.hS
G4_2201801.h5
G4_2201901.h5

M G4_202001.h5 /
I~ =

Slab:

The title bar of the Image Window shows that slabs 2-4 are displayed
out of a total of 5 slabs in the file.

o Adxv — G4_2_00001.h5 ([2-4]/5)




The Save Window

This window is accessed by clicking File->Save in the Control Window. Data from
the Image, Magnify and Line windows may be saved to a file in various formats.
The Line window may display either a histogram or a 1-d cross section of

the data. Whichever is displayed in the Line window will be saved.

[Z Adwsae [0

Directory and File where the

Directory: |/home;’arvaiftesil
saved data will be written.

File: FC3_1_00001.ps

Window Format
¢ Image ) Ascii
_J Magnify _J) Binary
_J Line ¢ Postscript

_J Tiff
_J Jpeg

Apply Close

Selects which format the data will be saved as.
See Output File Formats (below) for more
information about these choices.

Selects which window data will be saved from.
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Output File Formats
* Ascii

For the Image and Magnify Windows, the output is NX columns and NY rows,
where NX is the width (in pixels) and NY is the height. For example, here is the
output of a 5x5 pixel region displayed in the Magnify Window:

443 462 387 439 413

439 2156 1566 472 425
488 25600 19114 757 420
451 563 609 483 431

396 415 410 440 424

For the Line window, there is a short header, followed by pairs of X,Y values, where
X is the distance (in pixels) and Y is the value. For example:

# Line from image: /home/arvai/test_images/pilatus.cbf
# Start: 1280 1119
#End: 12901119
# Linewidth: 1

# Interpolation: 1
#

0 406.000000

1 469.000000

2 449.000000

3 488.000000

4 25600.000000
519114.000000

6 420.000000

7 410.000000

8 393.000000
9434.000000

Note that the x-coordinate (distance) is relative to the Start position in the header.



* Binary

This is only an option for the Image Window. The entire image is written, regardless of
how much is visible. The output format is ADSC img format. There is an ASCII header
which looks like this:

{
HEADER_BYTES= 512;

DIM=2;

SIZE1=2463;

SIZE2=2527,
TYPE=unsigned_short;
BYTE_ORDER=little_endian;
DISTANCE=80.001;
PIXEL_SIZE=0.172000;
WAVELENGTH=0.980800;
"L

The header is padded to HEADER_BYTES bytes and is then followed by the raw data,
which is 16-bit unsigned shprt. The output data will be signed 32-bit integer if Adxv is
started with the —smv32bits command line option. In this case the header is slightly
different, with:

TYPE=long_integer;

Images may also be converted to and saved as .img files with the —sa command
line option. See examples on pages 9 and 10.

Here is a library and documentation to read/write ADSC SMV/IMG files:

http://www.scripps.edu/~arvai/adxv/data/smyv.tar.qgz




* Postscript

Writes level2 color postscript. If Adxv is started with the —levell command line
option, then levell postscript will be written.

* Tiff

Tagged image file format.

* Jpeg
Standard JPEG format.



The Line / Histogram Window

The Line Window displays a 1-D cross-section plot of data from the Image or
Magnify Windows. Pressing and dragging the left mouse button in the Image or
Magnify Window will draw a rubberband line. When the mouse button is released,
the data selected by that line will be displayed as a 1-D plot in the Line Window.

The horizontal scale is millimeters and the vertical scale is pixel value. The total
length of the displayed data (in millimeters) is shown in the upper right. An
estimate of the crystal lattice length based on distance between adjacent peaks is
also shown.

Pressing the Left mouse button will display the X and Y coordinates. Pressing and
dragging the Middle mouse button will adjust the vertical scale of the plot

Total length of data
(millimeters).

Length: 14.6 mm
Lattice: 117.9 A

6000

This spot spacing, corresponds to this reciprocal lattice
spacing.
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Magnifying a region of an image, and then plotting a cross-section through it.

[ I
16000 Length: 13.5 mm __

Lattice: 128.2 A
12000 —
8000 1 —
4000 —
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Overloaded pixels are drawn in Yellow. Notice the cross-section has a flat top.

Adxv — /hgme/arvai/test_images/C3_l _00001.img \ .

0'.' - .

—| Adxv Line
g0000l | '
40000
20000
0 —
d 300 1800 2700 3600




The Line Window may also display a histogram of the data in the Image or Magnify
Windows. This is selected from the View->Histogram pulldown menu in the Control
Window. The histogram of either the Magnify Window (View->Histogram->Magnify) or
the entire image (View->Histogram->Image) may be selected.

The horizontal scale is pixel value and the vertical scale is number of pixels.

Two vertical dashed lines are drawn at the pixel values displayed above and below the
contrast slider in the Control Window and represent the min and max pixels values in
the colormap. Values below the min pixel value are drawn as white and values above
the max value are drawn as black. Pixel values intermediate to these values are drawn
as a grayscale

The Left Mouse button can be
used to adjust the min pixel
value slider and the Right
Mouse button will adjust the
max value. The Middle mouse
button will adjust the vertical
scale of the plot.

|

9.0e+04 :

370, 9551

6.0e+04

A small red cross is drawn at the horizontal position of the cursor. The X- and Y- values
of this coordinate are displayed in the upper right. The left and right arrow keys may
be pressed to move the cursor 1 pixel in each direction.



The Info Window

This window is accessed by clicking View->Image Header in the Control Window.
This will show the image header for the displayed image. Below are some example
image headers for various image formats.

" Adxv Info <@rad10>

ADSC img
q1.img =
HEADER_BYTES= 512;
DIM=2;
BYTE_ORDER=3igT]endian:
TYPE=unsigned_short; - )
SIZE1=1152; Adxv Info -
SIZE2=1152;
PIXEL_SIZE=0.0870; FORMAT :100
BIN=none; VERSION:15
ADC=slow; HDRBLKS:15
DATE=Sun Jun 8 13:146:13 1337; TYPE :Omega Scan Image
TIME=150.00; SITE :BRUKER21
DISTANCE=50.000; MODEL :D85 [?] with FIXED CHI
OSC_RANGE=1.000; USER  :BrukerAdministrator
PHI=0.000; SAMPLE :
QSC_START=0.000; SETNAME:
RUN 1
SAMPNUM: 0
I~ TITLE :
TITLE
Close | TITLE
TITLE
TITLE
TITLE
- TITLE
. Adxv Info <@radl0> l
e
H##HCBF: VERSION 1.5, CBFlib v0.7.8 - Close \
data_1327226846_00000 - -
_array_data.header_convention "PILATUS_1.2"
_array_data.header_contents Bruker
# Detector: PILATUS BM, S/N 60-0113,
# 2012-01-22T02:07:29.073
# Pixel_size 172e-6 mx 172e-6 m
# Silicon sensor, thickness 0.000320 m
# Exposure_time 1,.9977000 s
# Exposure_period 2,.0000000 s
# Tau=199.1e-09 5
# Count_cutoff 1179359 counts
# Threshold_setting: S300 eV
# Gain_setting: mid gain {vrf = -0,200)
{
I~ ] =
Close | .
mini-CBF
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_ Adxv Info <@rad10> NUMPY
NUMPY 1,0 Y
e — Adxv Info - | Mar CCD
'descr's '<fg’, r
'fortran_order": False, ./CG4high_1_033.mccd —
‘shape”: (1800, 1800),
3 total_pixels_x 4096
total_pixels_y 4096
bytes_per_pixel 2
bytes_per_record 8192
bits_per_pixel 16
data_type 0
saturation 65535
overflow_location 0
over_8_bits 1]
no_overflows 0
distance 300
beam_x 2048
= , beany 2048 i
' — Adxv Info |
FI1 | ./bioSaxsMetadata.edf =
EDF_DataBlockID = 0.Image.Psd ;
EDF_BinarySize = 4092732 ;
; EDF_HeaderSize = 1536 ;
ByteOrder = LowByteFirst ;
DataType = SignedInteger ;
Dim_1 = 981 ;
Dim_2 = 1043 ;
Inage = 0 ;
HeaderID = EH:000000:000000:000000 ;
Size = 4092732 ;
YersionNumber = 0.10 ;
Date = Wed May 12 16:13:16 2010 ;
count_time = 20.000000000 ;
File - M ndeesd —dop 172e-6m % 172e-6 m
Adxv Info | - .
[ [}
JLCLS/f_11_ENRC =1.01856e-312
/LCLS/f_12_ENRC = 5.95329e-310 Close
JLCLS/f_21_ENRC =86.95329e-310 EDF
JLCLS/f_22_ENRC =6.93648e-310
/LCLS/fiducial = 62214
JLCLS/machineTime = 1298270150
/LCLS/phaseCavityChargel = 6.93645e-310
/LCLS/phaseCavityCharge2 =0
JLCLS/phaseCavityTime1 = 2.32705e-319
/LCLS/phaseCavityTime2 = 5.093e-317
/LCLS/photon_energy_eV = 9385.21
/LCLS/photon_wavelength_a = 1.32108
/data/
/data/data —> /datafrawdata
/data/rawdata = 1480 x 1552, H5T_STD_I16LE
/processing/
/processina/hitfinder/ -
/processing/hitfinder/peakinfo = 121 x 3, H5T_I| ;
4] [
Close
40
| | HDF5




With an hdf5 file, header entries with 2 or more dimensions are displayed in a bold
font. If you double-click one of these with the Left mouse button, then Adxv will load
that dataset. Adxv will also remember the dataset name and will try to load it from

future hdf5 files.

Dataset name. If starting Adxv
with the -hdf5dataset command
line argument, this is the name

you would use.

/

Data type. In this case, F32LE
is floating point, 32-bit, little
endian.

p—

/

Adxv Info

J

Double-click to

!
/LCLS/

/data

/LCLS/Whoton_energy_eV = 3000
/LCLS bhoton_wavelength_a =4.1328

/data/data = 1456 x 1456, H5T_IEEE_F32LE, HSZ_FILTER_DEFLATE/

1

load this dataset

T

fe]

Close |

Dimensions of the data array in pixels.

|

Filter (if any) needed to decompress the data.
In additions to the standard HDFS5 filters, Adxv

will also recognize the LZ4 filter.



The Predictions Window

This window is accessed by clicking View->Predictions in the Control Window.
Spots can be automatically or manually picked and displayed.

- 1
[~ AdwPredictions | |||
Automatic Peak Search

Max. # of Spots: |30C§ A ﬂ
Min. I/Sigma: |55.00 Al !l
Min. Spot Spacing: |EF AY

Ignore Ice Rings: _|
Fast Peak Search: ¥

Avoid Zero Pixels: ¥

Find Peaks

Manual Peak Picking
) Add Peaks
¢ Spot Info

) Remove Peaks

Spot Info
H: t K: I: L: l:
X[ C mm
v: ﬁ ) pixels

Close

| Show Predictions

Max # of Spots specifies the maximum
number of spots to find. All the found
spots are sorted based on I/Sigma and the
largest are saved. If Max is set to 0, then all
spots are kept.

Min 1/Sigma saves only spots larger than
the specified I/Sigma.

Min. Spot Spacing saves only the larger of
two spots if they are too close. Distance is
in pixels.

Ignore Ice Rings will not use spots near ice
rings.

Fast Peak Search uses a different peak
search algorithm.

Avoid Zero Pixels ignores spots near pixels
which have a value of 0

When Find Peaks is clicked, spots will be
searched, saved in a files called peaks.file
and then displayed on the image with a
box around each spot




The first line of the peaks.file file is “DPS-PF A1.0”. This is followed by
pairs of Y, X values. For example:

DPS-PF A1.0

614.36 796.76
542.30 798.36
579.09 791.72
672.28 573.30

If Adxv is started with the —peaks _adx command line option, then a
peaks.adx file is also written. This contains X Y, I/Sigma:

796.76 614.36 362.67
798.36 542.30 231.83

791.72 579.09 202.38
573.30672.28172.72

In both cases, the X,Y values are in pixels.

Both the peaks.file and peaks.adx files are recognized by Adxv as spot
files and may be used to display spot positions. For example:

adxv test_1_001.img peaks.file

or

adxv test_1_001.img peaks.adx



(| AdwPredictions | -|

Automatic Peak Search

Max. # of Spots: |300§ AY
Min. I/sigma: [s00 | A V]
Min. Spot Spacing: |8 Aﬂ

Ignore Ice Rings: _|
Fast Peak Search: ¥

Avoid Zero Pixels: ¥

Find Peaks

Manual Peak Picking

_J) Add Peaks
¢ Spot Info

) Remove Peaks

Spot Info

H:F K:F L:F

v: r _) pixels

| Show Predictions Close

X: ﬁ ® mm Am———

Add Peaks — Select this to manually add
spots. Click on a spot in either the Image
or Magnify Windows with the Left mouse
button to add a spot.

Spot Info — Clicking on a spot displays the
X and Y position of the spot in the text
boxes below.

Remove Spots — Clicking on a spot with
the Left mouse button will remove it.

When a denzo .x file is loaded, clicking on
a spot with the Left mouse button will
display the HKL and X,Y value of that spot.

The displayed X,Y value may be selected to
be mm or pixels, but the output peaks.file
is always pixels.

Un-checking this box will turn off the display of spots. Same

o n

as typing “p” in the Image or Magnify Windows.
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The Statistics Window

This window is accessed by clicking View->Statistics in the Control Window.

When the Right mouse button is clicked in either the Image or Magnify Windows,
statistics of data in a box centered on the mouse position are calculated and
displayed.

[l Adwstatistics |- ]

Box Size: |11 X |1 1 Pixels

Center of Mass: F?SS.SEI 1769.47 Pixels

F
F

k??.s?

Average: i?53.82§
Std. Deviation: iazo.wﬁ Close

133.58 mm

Box Size specifies the area of the region over which to calculate statistics. If the
area of the Box is 0, then all the pixels in the Magnify Window are used.

The Center of Mass is displayed in both Pixels and mm.

The Average pixel value as well as the Standard Deviation are calculated and
displayed.
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The Settings Window

This window is accessed by clicking Edit->Settings in the Control Window. Distance
and Pixel Size are in millimeters, Wavelength is in Angstroms and 2-Theta is in
degrees. The beam center may be entered and displayed in pixels or millimeters,
depending on the setting of the adjacent radio box.

When a new image is displayed, these values may be overwritten by values in the
image header. To avoid this and keep the values as they are, check the box under
Fix and next to the relevant parameter

[ Adwsetings | [

Here the Wavelength is fixed,

Fix
NP |—179.950§ Cmm) o §o a valge read in from ‘a new
image will not change this.
Pixel Size: |o.102532 {mm) |
wavelength: |1.03316 | (A) 4

2-Theta

) Horiz.

Eo.oo { deg) _ 2-theta may be Horizontal or
« Vert. . .
\ Vertical. When Horizontal, the

detector rotates about a
Beam Center vertical axis and when Vertical
the detector rotates about a

X: 1523 4A’ ahnm X |
~ _ orizontal axis.
v:|150§ "4/ @ pixels

| Small Spots

_| Fix Contrast Close
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[Z " Adwsetngs |- ]
Fix

Distance: |1?9.950§ {mm) _

Pixel Size: [0.1025% | (mm)

wWavelength: |1.0331E§ (A)

2-Theta

0,00 {deg)

‘A’ Jmm
-  pi
y: |1503 !IJ pixels
| Small Spots =

_ | Fix Contrast Close

The position of the beam center
may be moved by 1 pixel by
clicking the appropriate arrow
button

The coordinates of the beam
center may be entered and
displayed in the text boxes to
the left in either millimeters or
pixels by selecting mm or pixels,
respectively.

When Small Spots is checked,
there is more smoothing of the
image displayed in the Image
Window. If spots are small and
every n’th pixel is simply
displayed without smoothing,
then some spots may not be
visible. This only affects the
display in the Image Window,

not the Magnify Window. See
examples on the next page.

When Fix Contrast is checked, the image contrast is not automatically
adjusted for each image as it is loaded. The may also be set from a pulldown
menu selected by clicking the Right mouse button in the colormap drawing

area of the Control Window.
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Effect of smoothing on an image which is scaled to 50%

No smoothing (every other pixel is
displayed). This can be selected with
the -nosmooth command line option.

This is the default setting. There is no
smoothing when the image is scaled to
100% and there is progressively more
smoothing as the image scale is
decreased.

More smoothing (about twice the
default). This can be selected with the
-small_spots command line option or
by checking the Small Spots checkbox
in the Settings Window.




The Properties Window

This window is accessed by clicking Edit->Properties in the Control Window. The
upper set of properties affect the display of the Line Window and the lower set
affect the display of the Image Window

E Adxv Properties |Jj

Line

Number of pixels orthogonal to the
Thickness: [1 | A V| o line direction which are averaged to
' form each point displayed in the
Line Window.

Interpolation: |(" None _)Linear

0verSampling:|f"1 J2 4 _lek

Plot Mode: | _JDots _)Line € Pix

o yne: [ 77 (O] 6)

Image

™ When a point falls between pixels, it’s
value may be either the closest pixel
or interpolated from close pixels.

¥ Show Pixels > |65000§ Number of points drawn per pixel

of length.

| Show Pixels < |—1§

Resolution Rings: | yon @ Off _)Anchorl

The line may be displayed as
Number of Colors: |.J18 32 64 @ max individual points, a line connecting
points, or a stair-step centered on
each pixel.

Slab Combine: |(" Sum _)Avg |

Close




The plot will be a straight line, where the first point is selected with the Left
mouse button. The mouse is then dragged and the end point is where the mouse
button is relezised

E Adkv Properties | 1| p The Left mouse button will select
the center of a circle. As the mouse
is dragged, the radius of the circle
Thickness:\l1 = A| V| increases. When the mouse button
is released, a circular arc of data will
be drawn, from 0 to 360 degrees

Line

Interpolation: A" None _)Linear

p.
over Sampling: ({21 2 4/08 | around the circle. The plot is
Y A counter-clockwise starting from the
Plot Mode: | I)Dots _JAine ¢ Plxell . )
right side.
Plot Type: ’/‘ ®|@|@|
Image

¥ Show Pixels > |55000§

| Show Pixels < |—1§

Same as above, except the edge of
\ the circle is selected and the mouse
Number of Colors: | 16 32 64 @ Max is then dragged to select the center.

Resolution Rings: Jon @ off JAncho

Slab Combine: |(" Sum _)Avg |

Close

As above, the center of a circle is selected with the Left mouse button and the
mouse is dragged to select the radius. The horizontal axis of the plot is radius (i.e.
distance from the center of the circle). The value at each radius is the circularly
averaged pixel intensity at that radius. May be useful for SAXS.




Pixels which are greater than or equal to
this value are displayed in a Yallew color.
This is used to show overloaded pixels.
When the Colormap is Heat, these pixels
are Blue and when the Colormap is
Rainbow these pixels are Green.
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Selects how to combine slabs
when multiple slabs from an hdf5
file are displayed.

Pixels which are smaller than this
value are displayed in a Red color.
This is to show bad pixels, i.e. with a
value of -2. When the Colormap is
Heat, these pixels are Green and
when the Colormap is Rainbow
these pixels are Yellow.

Draw circles on the Image Window
showing the resolution. Default is 5
circles. See the -rings and —rfont
command line flags for more
options. Note that these resolution
rings are not circular when 2-theta is
non-zero. When  Anchorl s
selected, a circle is drawn about the
beam center, through the next point
selected with the Left mouse
button. The diameter of this ring will
change as the beam center is
changed. This is useful for fitting the
beam center from ice rings or
checking anisotropic scattering.

Number of colors to use for the
colormap when displaying the
image.



The Background Window

This window is accessed by clicking Edit->Background in the Control Window. You can
display the background of an image as well as subtract or divide the background from
an image. This may also be used to add or subtract images.

Select whether the background is read from a file
or calculated from the current image.

Display will calculate and
display the background of the
current image.

Divide will divide the current

image by either a file or a /

calculated background.

Subtract will subtract the
background (either calculated
or read from a file) from the
current image. The percentage
of the background to subtract
may be specified. 50% specifies
half the background will be
subtracted. If the percentage is
negative, the background is
added. For example -100% can
be used to sum two images.
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Filp:

Background Calculation
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Apply to
Original
Close Displayed

Image




X Adxv Background <@radli0> — (=] K

Background Source
+ Display “ File
v Divide v Calculate

4 Subtract [100.d %

Background File

If File is selected as the
Source, then the Directory
and File are specified here.

Directory: /home/arvaiftest

File: C3_1_00001.img

Background Calculation

4 Local (Moving Average)

v Radial (Symmetry about Beam Center)

Apply to
Original |
h
Close | Displayed |

Image

Select whether the
background is applied to
the Original image or the
currently Displayed image.
The difference is that the
currently displayed image
may already have had some
background subtracted.

The background may be calculated using a Local moving average or based on
Radial symmetry about the beam center. For the later, make sure the beam

center is correct.




The Socket interface

When Adxv is started with the —socket command line option, it will listen for a
connection on port 8100. Commands may be sent to Adxv over this connection.
Commands can be sent to load images, display spots or raise windows. Below is a list of
commands which can be sent.

box x y Size of box drawn around spots.

define_type n color <color> radius Define a spot type. Color is one of red, green
<radius> or Blue. Radius is in pixels.

load_image <image file> Load an image file

load_spots N Read N spots

Xy type Spot at pixel position x y

end_of_pack End of spot data

raise_window <window> Raises a Window. <window> must be one of

Control, Image, Magnify, Line, or Load.

exit Exit Adxv

Here is an example:

http://www.scripps.edu/~arvai/adxv/data/adxv socket example.c

To run:

cc -0 adxv_socket_example adxv_socket_example.c
adxv -socket &
.Jadxv_socket_example

This will load an image file, display 4 spots of various sizes and colors and raise the Load
Window. You will need to change the name of the image file in the code. An example

image is available here:

http://www.scripps.edu/~arvai/adxv/data/ql.img.gz




The Beam Center File

Whenever Adxv reads an image file, it checks to see if there is a .adxv_beam_center
file in the directory where the image is being loaded from. If this file exists, then it
will be used to set the beam center. The reason for this is that sometimes the beam
center written in the image header is not correct. If it is adjusted one time, then all
images in that directory will be displayed with the correct beam center.

If the .adxv_beam_center file does not exist or if the user adjusts the beam center in
Adxyv, then this file will be written. The file contains 4 ascii numbers:

beam_x beam_y nx ny

beam_x and beam_y are the coordinates of the beam center and nx and ny are the
image dimensions. For the beam center to be used, the image dimensions of the
displayed image must match nx and ny.

To not read or write the .adxv_beam_center file, Adxv can either be started with the
-no_adxv_beam_center command line option or the NO_ADXV_BEAM_CENTER
environment variable may be set.



Frequently asked Questions

Is there any license or fee for using Adxv?
No, it is free for anyone to use.
Where can | download adxv from?

www.scripps.edu/~arvai/adxv.html

What if Adxv complains about missing fonts?

You can install the missing fonts from these packages:

xorg-x11-fonts-75dpi.noarch
xorg-x11-fonts-ISO8859-1-75dpi.noarch

You can also download all the fonts Adxv needs from:

http://www.scripps.edu/~arvai/adxv/fonts.tar.gz

Put this file in a directory (i.e. /usr/share/adxvfonts/) and type:

gunzip --stdout fonts.tar.gz | tar xvf —

Then run Adxv with the font path option:

adxv -fp /usr/share/adxvfonts

What if | download Adxv and get "./adxv: Permission denied."?

chmod +x ./adxv



What if the Image Window doesn't refresh correctly under NX?
This is a bug in NX and should be fixed in newer versions of the NX server.
Try typing Ctrl + Alt + E to toggle lazy encoding.

Depending on the version of NX, try adding one of the following options on
the machine which is running the nxserver:

Jusr/NX/etc/node.cfg
AgentExtraOptions="-defer 0"

/etc/nxserver/node.conf
AGENT_EXTRA_OPTIONS_X="-defer 0"

Other things to try:

adxv -nopixmap

adxv -nopixmap -nobs

Complain to nomachine (https://www.nomachine.com/report-issues )
As a last resort, contact me (arvai@scripps.edu)

Is there a version of Adxv which runs under Windows?

If ¥tou install cygwin (http://www.cygwin.com/ ) and the x-server packages
(http://x.cygwin.com/docs/yg/setup-cygwin-x-installing.html ) then the
cygwin version of Adxv should work. Adxv was compiled under Windows 8.

This will also run under Windows 7, but only if you ||P1$te%ll tge 32-bit
version of cygwin. Thanks to Dr. llya Frantsuzov for this feedback.

Adxv crashes in with "Library not loaded: /usr/X11/lib/libXt.6.dylib”

In OSX 10.10 (Yosemite) the X11 libraries were moved from /usr/X11 to
/opt/X11. You can make a symbolic link from /opt/X11 to /usr/X11:

In -s /opt/X11 fusr/X11

What if none of the binaries run on my machine or | find a bug?

Contact me at arvai@scripps.edu

What if | want to donate money to fund Adxv support and development?

Definitely contact me.



Command line options

-autoload

Automatically load images listed in the file
SXFORMSTATUSFILE. This file should contain one line
with two values, an integer number and file name. This
file is checked every two seconds and when the integer
number changes, the specified file name is loaded and
displayed.

-auto_sigma

As the cursor moves across the Image Window, the I/
Sigma of the region under the cursor is calculated more
accurately, but more slowly. This is done by default in
the Magnify Window.

-beam_center x y

Specify the beam center in mm. Default is read from the
image header.

-beam_center_pixels x y

Specify the beam center in pixels. Default is read from
the image header.

-border Draw a 1 pixel border around the image.

-bruker Input file is Bruker (.sfrm) format.

-char Input file is binary signed chars

-colormap Create a new colormap instead of using the default one.

-colors Gray|Heat|Rainbow

Defines the initial colormap colors. Default is Gray.

-contrast Min Max

Set the initial values for the contrast setting. Default is
automatic.

-debug

Print debugging information.

-delay t

Delay (in milliseconds) for displaying images in movie
mode.

-display DISPLAY

X11 display to use

-distance x

Specify the crystal to detector distance in mm. Default is
read from the image header.




-double

Input file is binary doubles

-edf

Input file is EDF format

-fast_scan_mmH|V

Specify the fast scanning direction for mm coordinates
displayed in the Image Window. Default is H (Horizontal).
See also -scan_origin_mm

-fast_scan_px H|V

Specify the fast scanning direction for pixel coordinates
displayed in the Image Window. Default is H (Horizontal).
See also -scan_origin_px

-find_peaks

Run peak search and exit

-fix_contrast

Do not automatically re-adjust the contrast as each new
image is read in. This may also be set in the Settings
Window.

flipH|V Flip the image about a Horizontal or Vertical axis.
-flip_beam H|V Flip the beam center about a Horizontal or Vertical axis.
-float Input file is binary floats

-fp FontPath

The Font Path

-fuji Input file is a Fuji image plate image.

-fujilObit Input file is a Fuji 10bit image plate image.

-gl If available, use OpenGL to render 3-d graphics in the
-use_gl Magnify Window.

-gl_lines Draw OpenGL 3-d graphics as a wire mesh. Typing "w"

in the Magnify Window will also toggle between a wire
mesh or polygonal surface representation.

-gl_quad_strip_bug

Draw the 3-d polygonal surface using GL_QUADS
instead of GL_QUAD_STRIP. This works around a bug in
some X-Servers.

-hdf5dataset <dataset>

Name of HDF5 data set (i.e. /data)

-hist32bits

Larger dynamic range for histogram (slower)




-ifont <fonthame>

Text font to use in the Image Window

-int
-raw

Input file is raw binary signed integers (4 bytes/pixel).

-invert_colors

Invert the colormap colors

-iscale X

Scale factor to multiply pixel values by

-itext

Draw text in image window with white background

-jpeg_quality N

Output jpeg quality. 0 is worst, 100 is best, default is 75.

-jpeg_scale X Output jpeg and tif scale. 0 - 1.0, default is 1.0
-levell Output levell postscript (default is level2)
-log Take the log of all the pixels: p = log(p)*1000
-long Input file is binary signed longs (8 bytes/pixel)
-marccd Mar ccd image
-mosflm Mimic Mosflm's coordinate system. Shortcut for:
-rotate 90 -flip V -scan_origin_px UL-scan_origin_mm UL
-ncolors N Use N colors for the colormap. Default is 1024. If N=0,
use the maximum possible
-newpixmap Create a new pixmap when a new image is read. The

default is to only create a new pixmap if the new image
is a different size

-no_adxv_beam_center

Neither read nor create the .adxv_beam_center file.

-noborder Do not draw a border around the image (default)

-nobs Do not use Backing Store on the display

-nofp Do not try to set up font path (default)

-nodisplay Do not display the image

-nopixmap Use a Window instead of a Pixmap in the Image Window.




-norotate Do not rotate mar .image files 90 degrees before
displaying.
-nosmooth When the image scale factor is less than 0.25, do not

smooth the displayed image. When a large image is
scaled down, small spots may not be visible if simply
every n'th pixel is displayed. Smoothing is on by default.

-nolabelPixmap

Labels are not drawn from Pixmaps

-numpy Input file is NUMPY format

-nx N Number of pixels in horizontal (fast) direction
-ny N Number of pixels in vertical (slow) direction
-o_direct Open files with O_DIRECT for faster I/O
-offset N Constant to add to all pixel values

-oldcontrast

Use older automatic contrast adjustment.

-overload N Pixel overload value. Pixels larger than this are drawn as
yellow. This may also be set in the Properties Window

-parallel Use multiple processors (up to 16)

-peaks_adx Write peaks.adx (X Y I/Sigma) for peak search.

-pixelmap <geometryfile>

CrystFEL geometry file or Cheetah pixelmap file

-pixelsize X

Pixelsize (mm)

-printheader

Print image header to the standard output

-ps

Display the Prediction Window at startup.

-q

Line Window horizontal scale is in g-space units

-rfont <fontname>

Font to use for resolution rings.

-rings [resl1, res2, ...]

Display resolution rings

-rings_only

Draw only the rings, not the resolutions




-rotate 90 | 180 | 270

Rotate the image 90, 180 or 270 degrees before
displaying it

-Sd

Standalone mode. This reads an image file, automatically
writes a jpeg, tiff or img file and then exits. It requires
an input image file and output file name as the last two
arguments, respectively. The output filename extension
(.tiff, .jpeg or .img) specifies the output format.

-sa_crop WxH+X+Y

In standalone mode (-sa), this will crop the output
image. The upper left corner is XY and the output
dimensions are W x H (pixels).

-scandir

Use stat() instead of d_type field to determine the file
type

-scan_origin_mm UL|UR|
LL|LR

The scan origin for mm coordinates displayed in the
Image Window. Default is LL (Lower Left).
See also -fast_scan_mm.

-scan_origin_px UL|UR|LL]|
LR

The scan origin for pixel coordinates displayed in the
Image Window. Default is UL (Upper Left).
See also -fast_scan_px.

-short
-sshort

Input file is raw binary signed shorts (2 bytes/pixel).

-show_underload

Show pixels below a threshold. See Properties Window.

-skip N

Skip N bytes before reading raw binary data. May be
used to skip a file header.

-slab_combine Sum|Avg

Sum or Average data when combining multiple slabs.
Default is Sum. Applies to multi-dimensional hdf5 data.

-slab N First slab of multi-dimensional hdf5 data to display

-slabs N Number of slabs of multi-dimensional hdf5 data to merge
and display

-slowcbf Slower routine to open CBF files

-small_cursor

Use a smaller crosshair cursor in the Image Window

-small_spots

Better image display for images with small spots




-smv32bits

Output img files will be 32-bit signed integer, instead of
16-bit unsigned short

-socket [port_number]

Adxv will listen for a socket connection on port number
8100. The port number may be set with the
ADXV_DISPLAY_PORT environment variable.

-spindle_orient H|V

Spindle Orientation (for DPS)

-spindle_rot clock|anti

Spindle Rotation (for DPS)

-stride N Number of Slabs/Files to step when loading the next
image

-swab Swap the two 8-bit halves of each 16-bit word

-swap

-swapbytes

-swap_beam_center

Swap x and y position of the beam center

-swaw Swap the two 16-bit halves of each 32-bit word

-swadw Swap the two 32-bit halves of each 64-bit word

-tiff Input file format is TIFF

-tiff32 Output TIFF file format will be 32-bit integer

-twotheta X 2-Theta angle in degrees. Default is read from the image
header

-uchar Input file is raw binary unsigned chars (1 byte/pixel)

-underload N

Threshold below which to show small pixel values. May
also be set in Properties Window.

-uint Input file is binary unsigned integers (4 bytes/pixel)
-ushort Input file is raw binary unsigned shorts (2 bytes/pixel)
-verbose More verbose text messages

-visual Visual Visual Class or ID to use. See xdpyinfo(1) or glxinfo(1).

-wavelength X

X-Ray wavelength in angstroms. Default is read from the
image header.




Environment Variables

ADXV_DISPLAY_PORT

ADXV_PATTERN

ADXV_SHOW/_PIXELS

DISPLAY
MARHOME

NO_ADXV_BEAM_CENTER

XFORMSTATUSFILE

OMP_NUM_THREADS

Port to listen for a socket connection. Default is 8100. Also
set with —socket command line argument

Pattern to list new images in the Load Window. Default is
*.img.

Pixel overload value. Pixels larger than this are drawn in
yellow. Default is 65000, but may be changed in the
Property Window.

Set the default host and display number.

If SMARHOME/fonts exists then this will be prepended to
the X Font Path. See -nofp.

Do not read or write the .adxv_beam_center file

File which specifies images to automatically load (see the
-autoload command line option).

Maximum number of threads to use when the -parallel
command line option is used. Max is 16.



